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1 Introduction 

This guide outlines the best practices and requirements for deploying Nitro PDF Pro for Windows. These 

settings can be customized to fit the specific needs and preferences of individual customers. 

To meet the diverse license management and deployment needs of various organizations, Nitro PDF Pro 

offers multiple installation options. This Installation Guide is specific to the Enterprise licensing model. 

This guide provides detailed information on installation options and how to handle scenarios such as 

advanced integrations or installations in non-standard environments. 

This document is intended for System/Application Administrators to guide the deployment and 

configuration of Nitro PDF Pro in an enterprise environment. 

 

If further assistance is needed, please see Section 7 for additional support resources. 

2 System Requirements 

• Operating System (Desktops): Windows 11 (64bit) and Windows 10 (64bit) version 

1809 or later 

• Servers: Microsoft Windows Server 2019 (64bit)  

• Processor: 1.5 GHz or faster  

• RAM: 1GB  

• Available Hard Disk Space: 4.5GB  

• Display Screen Resolution: 1024x768  

• Microsoft Office Integrated Features: MS Office 2013 (32bit or 64bit), MS Office 

2016 (32bit or 64bit), Microsoft Office 2019 (32bit or 64bit)  

• Video Hardware Acceleration:  Optional  

• iManage: To support iManage integration: 

o server:  iManage 10.2 and newer (cloud or on-premises) 

o client:  iManage Work Desktop for Windows 10.5 and newer 

• Microsoft Visual C++ Redistributable (version 14.44.35211.0 or later) 

o x64-bit VC++ redistributable required for all users 

o x86-bit VC++ Redistributable required for use with Office x86 

 

Please check the Technical Requirements page for the latest Nitro PDF Pro system requirement updates. 

3 Installing Nitro PDF Pro (for Windows) – Enterprise Version 

Nitro offers different licensing methods for its software. This guide is specifically for the Enterprise version 

of Nitro PDF Pro which is installed using a MSI (Microsoft Installer) deployment package and activated 

using a license (.lic) file with a 32-character alphanumeric name.   

Before you install the Enterprise version of Nitro PDF Pro, make sure your organization is using the 

Enterprise licensing model and has received a Nitro PDF Pro license file. You cannot activate the 

Enterprise version of Nitro PDF Pro without a license file. 

If you are unsure which licensing model your organization uses, please contact Nitro Support. 

 

https://www.gonitro.com/product-details/technical-details
https://www.gonitro.com/support/ticket
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3.1 Nitro PDF Pro (for Windows) Installers (Enterprise) 

Nitro PDF Pro can be installed on individual computers or deployed to multiple computers without any user 

interaction using a software deployment application or Group Policy. 

MSI packages are widely used for software installation on Windows operating systems. The Nitro PDF Pro 

MSI deployment package is specifically designed for enterprise environments, where applications are 

deployed across the entire organization. To accommodate a large user base and comply with common 

security policies, some front-end options have been disabled.  

The latest Enterprise version of Nitro PDF Pro (for Windows) can be downloaded at:  

https://www.gonitro.com/installers/CV/enterprise/download. 

Please note: Please ensure the Microsoft Visual C++ Redistributable (x64) is up to date before installing 
Nitro PDF Pro. 
 
3.1.1 Default Settings 
 
The following features are enabled in Nitro PDF Pro (for Windows) by default: 

• Nitro PDF Pro desktop shortcut 

• Microsoft Office (Word, Excel, PowerPoint, Outlook) add-in 

• Nitro PDF Pro printer driver (required for creating documents) 

• Integration with Nitro Sign (eSigning) 

• Crash reporting 

• Integrations with supported Document Management Systems (DMS), including 

Box, Dropbox, OneDrive, and SharePoint Online. 

• Knowledge Assistant  

 

3.2 Installation Methods 

To install Nitro PDF Pro, you have multiple options to choose from depending on your preferred method 

and technical expertise. Below are the three ways to install the software: 

1. Manual Installation: Run the MSI file and follow the installation wizard prompts. 

2. Command-Line Installation: Use the command-line or a script to run the msiexec 

command. 

3. Automated Installation: Deploy via a software package like Microsoft System 

Center Configuration Manager (SCCM) or Intune. 

 
We recommend installing Nitro PDF Pro using the default settings. However, it is possible to customize 

these settings by creating a custom MST file using the Nitro Deployment Utility or an MSI-editing tool like 

Orca. For more details on creating an MST file, please refer to Section 3.3 of this guide. 

This guide also includes information on installing Nitro PDF Pro in other environments, such as Virtual 

Desktop Infrastructure (VDI) or Hosted Desktops, deploying via Microsoft App-V, and installing OCR 

language package add-ons. 

  

https://www.gonitro.com/installers/CV/enterprise/download
https://learn.microsoft.com/en-us/cpp/windows/latest-supported-vc-redist?view=msvc-170#latest-supported-redistributable-version
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3.2.1 Manual Installation (Default Settings) 

Nitro PDF Pro can be installed on a Windows-based computer that meets the prerequisites by simply 

starting the MSI installation file with a double click. This method is typically recommended when installing 

on individual workstations. 

1. Download the Nitro PDF Pro 26 installer 

 

2. Close all Microsoft Office applications (Word, Excel, PowerPoint, Outlook) 

 

3. Run the downloaded package with elevated privileges. (Run as an Administrator if your user 

account does not have installation rights.) 

 

4. Follow the prompts presented by the installer 

 

5. Select the installation location. The default (recommended) location is C:\Program 

Files\Nitro\PDF Pro\CV\ 

 

6. Leave the box checked to install the Microsoft Office add-ins for Word, Excel, PowerPoint, and 

Outlook 

 

7. Select the desired 

application language 

from the drop-down. 

English is the default 

language, but Nitro PDF 

Pro is also available in 

German, French, 

Spanish, Dutch, and 

Italian.  (The application 

language can also be 

changed post-

installation. See Section 

6.1 for details.) 

 

8. Click Install to begin the 

installation process 

 

9. Please wait for the 

installation of Nitro PDF 

Pro to complete, then 

click Finish 

  

https://www.gonitro.com/installers/CV/enterprise/download
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3.2.1.1 Activating Nitro PDF Pro (Manual / Individual Workstations) 

Nitro PDF Pro is activated using a license (.lic) file.  This is a straightforward process designed to ensure 

you can access and utilize the full capabilities of Nitro PDF Pro. This method provides a seamless and 

secure way to activate Nitro PDF Pro.  

Follow the steps below to activate Nitro PDF Pro and get started: 

1. After Nitro PDF Pro is 

installed, go to the Help 

tab, and click on the 

Activate button 

 

2. You will be presented 

with a pop-up window 

prompting for License 

Information 

 

3. Enter the user’s first 

name and last name 

 

4. Click Upload License to 

upload the Nitro PDF Pro 

license file (.lic) 

 

5. Check the box to accept 

the Terms of Service 

 

6. Click OK 

 

 

 

Note: If you don't see an Activate button on the Help tab or are asked to enter an 18-digit serial 

number instead of uploading a license (.lic) file, it means the Enterprise version of Nitro PDF Pro is 

not installed.  

 

Please ensure you have installed the version of Nitro PDF Pro that corresponds with your license 

type.  

 

If you're unsure which licensing model applies to you, please contact Nitro Support. 

 

 

  

https://www.gonitro.com/support/ticket
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3.2.2 Installing on Multiple Workstations Using Command-Line (Default Settings) 

Nitro PDF Pro can be deployed on one or more workstations (without any user interaction) using a 

command-line script. Using the command-line script, Nitro PDF Pro can be installed and activated at the 

same time.  

 

The steps to install Nitro PDF Pro with the default settings using the command-line prompt are detailed 

below: 

1. Download the Nitro PDF Pro 26 installer (MSI package).  

 

2. Copy the full serial number. To obtain the full serial number (typically between 400-500 

characters), open the Enterprise license file (.lic) in Notepad and copy the full string. 

 

3. Deploy the Nitro PDF Pro package by executing the following command-line script:  
msiexec /i “Path-to-Installation-File” /qn NPSERIAL={Insert-Full-

Serial-Number-here} 

 
Example:  
msiexec /i “C:\Users\jsmith\FolderName\nitro_pro_x64.msi” /qn 

NPSERIAL=eyJQYXlsb2FkIjp7IkN1c3RvbWVyTmFtZSI6IkdIRCBTZXJ2aWNlcyIs

IlByb2R1Y3ROYW1lIjoiIiwiTGljZW5zZVV1aWQiOiI5NGVjMWE3My1kMzJjLTRmZ

mUtYWQ5Zi1kMzMyM2ZkMmEwYjEifSwiU2lnbmF0dXJlIjoiQVRrcm16R1lNaU1NdU

0zdU9QcW5sQ3p5c2J1bkE4QmRqYXgwSE9EY0RCZ3JBSUJSamlnK2dPT09RRENQRzR

UKzd4ZWZmUWlNWklKa3VwTXBKcjBueW5rSEFDSGs1YWUwNWdoWm4yZmZrSCtsVHB3

M0tpanc4dmU1NlQySU5DNGp4WDA2TTU2d2FYUjlIcUhWZHErL0ZkSDQyWEhw 

UjN0e16R1lNaU1NdU0zdU9Qc  

 

• “msiexec” is the Windows Installer command-line utility. 

• “/i” specifies that you want to install the package. 

• "C:\Users\jsmith\FolderName\nitro_pro_x64.msi" is the path to 

the MSI installer file. 

• “/qn” specifies a quiet installation with no user interface. 

• NPSERIAL is the MSI Property for the Nitro PDF Pro serial number. 

More information about command-line options can be found at https://learn.microsoft.com/en-

us/windows/win32/msi/command-line-options.  

 

3.2.2.1 Activating Nitro PDF Pro after Installation Using Command-Line 

Nitro PDF Pro can be activated separately from installation using a command-line script. To activate Nitro 

PDF Pro after installation (or to reactivate Nitro PDF Pro with a new license file), use the following syntax: 

“C:\Program Files\Nitro\PDF Pro\CV\ActivateSN.exe” -s <FULL SERIAL NUMBER> 

For more details, see Section 5.4. 
  

https://www.gonitro.com/installers/CV/enterprise/download
https://learn.microsoft.com/en-us/windows/win32/msi/command-line-options
https://learn.microsoft.com/en-us/windows/win32/msi/command-line-options
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3.2.3 Installing on Multiple Workstations Using a Software Package (Default Settings)  

Nitro PDF Pro can be deployed on one or more workstations (without any user interaction) using a software 

deployment solution such as SCCM or Intune. Deploying software via SCCM or Intune provides a robust 

and efficient method for managing installations across your organization.  

System Center Configuration Manager (SCCM) offers comprehensive tools for deploying, updating, and 

maintaining software on a large scale, ensuring consistency and compliance across all devices. SCCM 

automates deployment processes, reducing the need for manual intervention.  

Intune, part of Microsoft Endpoint Manager, enables cloud-based management, allowing you to deploy 

software to users and devices wherever they are, enhancing flexibility and support for remote work 

scenarios. Intune integrates with other Microsoft services for comprehensive device and application 

management. 

Leveraging SCCM or Intune can help to efficiently deploy Nitro PDF Pro to multiple workstations, ensuring a 

seamless and consistent user experience. Both tools streamline the deployment process, reduce manual 

intervention, and provide detailed reporting and analytics to monitor the success of your software rollouts. 

For more detailed information on using SCCM and Intune, you can refer to the following resources: 

• Deploy Applications with Configuration Manager 

• System Center Dudes Guide 

 

  

https://learn.microsoft.com/en-us/mem/configmgr/apps/deploy-use/deploy-applications
https://learn.microsoft.com/en-us/mem/configmgr/apps/deploy-use/deploy-applications
https://www.systemcenterdudes.com/sccm-windows-10-deployment-guide/
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3.3 Customizing Nitro PDF Pro Installation Settings  

 

The default Nitro PDF Pro installation settings can be modified either by using the command-line prompt or 

by creating an MST (Transform File).  Either method can be used to customize Nitro PDF Pro’s settings to 

better fit your organization's specific needs. Command-line is typically used for simple adjustments (one or 

two small changes), while the MST file tends to be used for more extensive modifications to the default 

installation settings.   

 

Note: Nitro recommends keeping the default settings unless there is a specific reason to modify them. 

 

 

3.3.1 Customizing Nitro PDF Pro: Creating an MST using the Nitro Deployment Utility 

 

 

The easiest way to create an MST is with a tool 

called the Nitro Deployment Utility. The Nitro 

Deployment Utility is a user-friendly, MSI 

customization tool that allows you to modify the 

default installation settings to comply with your 

organization’s security policies and IT 

standards.  

 

By creating a MST file, your custom 

configurations are applied to your Nitro PDF Pro 

deployment. 

 

The Deployment Utility is version-specific and 

can be downloaded from the Enterprise installer 

page.  

 

 
 

 

To use the Nitro Deployment Utility, open the EXE file. Upload the Nitro PDF Pro installer (MSI) into the  

https://www.gonitro.com/installers/CV/enterprise/download
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Deployment Utility by clicking Browse and selecting the Nitro PDF Pro MSI file. 

 

The installation settings can be changed by checking or unchecking the boxes for the various installation 

options.  

Once all desired settings have been selected, click the box to agree to the Terms of Service, then click 

Generate MST File. An MST file will be created and saved to the same location as the uploaded 

nitro_pro_x64.msi. 

 

 

3.3.1.1 General Settings 

 

The following screenshots display the default 

installation settings for Nitro PDF Pro. 

 

The following tables detail the customizations 

available through the Deployment Utility.  

 

To enable or disable settings, simply check or 

uncheck the boxes displayed in the Deployment 

Utility.  

 

For settings that can be modified via the 

command-line (CMD) prompt, the corresponding 

MSI Property is detailed. For details on modifying 

default settings using command-line, see Section 

3.3.3. 

 

 “General” Tab of Deployment Utility 
Setting Description MSI Property 

Create desktop 

shortcut  
Leaving this box checked will result in a Nitro PDF Pro 

desktop icon/shortcut being added to the users' desktops.  

DT_SHORTCUT  

(Enabled = 1 / Disabled = 0) 

Install toolbars for 

MS Word, Excel, 

Outlook & 

PowerPoint 

Leaving this box checked will install the Nitro PDF Pro plugin 

directly to the Office toolbar/ribbon, allowing PDFs to be easily 

created/converted directly from within MS Office applications. 

OFFICEADDINS 

(Enabled = 1 / Disabled = 0) 

Install printer driver 
Leaving this box checked will install the Nitro PDF Creator 
which allows users to create PDF files. 

INSTALL_PRINTER_DRIVER  
(Enabled = 1 / Disabled = 0)  

Enable Nitro Sign 

integration  

Checking this box will enable Nitro Sign to be accessed directly 

from Nitro PDF Pro. Unchecking this box will disable the Nitro 

Sign integration from within Nitro PDF Pro.  

SIGNENABLE  
(Enabled = 1 / Disabled = 0) 

Enable crash 

reporting and hang 

detection 

Checking this box enables reporting when Nitro PDF Pro 

crashes or has stopped responding. The user will be prompted 

to send a crash/bug report if Nitro PDF Pro crashes or hangs. 

BUGSPLAT_SENDREPORT_ENAB

LED 

(Enabled = 1 / Disabled = 0) 

Language 
The default application language is English, but the default 

can be changed to German, French, Spanish, Italian, or Dutch. 

APPLICATION_LANGUAGE 

(de-DE; en-US; es-ES; fr-FR; it-IT; 

nl-NL) 

Enable 

integration with 

Dropbox  

Leaving this box checked will enable users to access PDF 
documents directly from Dropbox.  

DROPBOXDISABLED  
(Enabled = #0 / Disabled = #1)  

Enable integration 

with Box  
Leaving this box checked will enable users to access PDF 
documents directly from Box.  

BOXDISABLED 
(Enabled = #0 / Disabled = #1) 

Enable 

integration with 

OneDrive  

Leaving this box checked will enable users to access PDF 

documents directly from OneDrive. 

ONEDRIVEDISABLED  

(Enabled = #0 / Disabled = #1) 
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Enable integration 

with SharePoint 
Leaving this box checked will enable users to access PDF 
documents directly from SharePoint Online. 

SHAREPOINTDISABLED 
(Enabled = #0 / Disabled = #1) 

Enable 

classification and 

labeling  

Checking this box will enable classification and labeling in 

Microsoft Purview Information Protection.  See Section 6.6 for 

more details. 

MSAZUREIPLABELINGENABLED 
(Enabled = #1 / Disabled = #0) 

Force Login 
Checking this box forces a user to log in to their Microsoft 365 

account when launching Nitro PDF Pro. The user must be 

logged in to M365 to enable the Microsoft Purview integration. 

MSAZUREFORCELOGIN 

(Enabled = 1 / Disabled = 0) 

3.3.1.2 Serial Number (Activation)  
 
 
 

Nitro PDF Pro is activated via a 

license (.lic) file. The license file can 

be easily uploaded and applied 

across multiple devices, simplifying 

the process of distributing and 

managing software within an 

organization.  

 

This activation method ensures that 

all users have unrestricted access to 

the software, enhancing productivity 

and reducing administrative 

overhead.  

 

To import the license file, from the 

Serial Number tab of the 

Deployment Utility, click Upload 

License and upload the Nitro PDF 

Pro license file. 

 

If you do not have a Nitro PDF Pro 

license file, please contact Nitro Support. 
 

 

 

 

 

“Serial Number” Tab of Deployment Utility 
Setting Description MSI Property 

Upload License  
Click “Upload License” to upload your Nitro PDF Pro 

license (.lic) file.  
NPSERIAL  

Proxy… Not applicable for Enterprise installations 
PROXYSERVER, PROXYUSER, 

PROXYPASS  

Encrypt  

By default, the Nitro PDF Pro license file is unencrypted. 

If you are ONLY deploying on desktops/laptops, you 

should consider encrypting the license file.  Encryption 

protects the license file from unauthorized access, 

ensuring that sensitive information, such as product 

keys or licensing terms, remains confidential. The 

license file must be unencrypted when deploying on 

virtual machines or a master image. 

NPSERIALENCRYPTED  

(Encrypt = #1 / Unencrypt = 

#0) 

https://www.gonitro.com/support/ticket
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3.3.1.3 Print Settings 

Configuring print settings when creating an 

MST file is a crucial step to ensure that 

Nitro’s printing functionalities are tailored to 

meet your organization's specific needs.  

Follow the steps below to customize your 

print settings. 
 

 

  

 

 

 

 

 

 

 

 

 

“Print Settings” Tab of Deployment Utility 
Setting Description MSI Property 

Default Settings  
In most cases, we recommend selecting “Default 

Settings” from the Print Settings dropdown.  
N/A 

Optimize for PCL 

driver  

If you experience issues when printing large 

image/graphic files to specific printers (typically Xerox 

brand PCL pull print drivers), selecting “Optimize for 

PCL Driver” is expected to resolve these specific 

printing issues. This setting can also be changed post-

deployment for individual users via the registry key 

settings.  

N/A 

 

  

 Alternate Method:  Print Settings can also be modified by updating a Windows (DWORD) Registry Key. 

 

1. Navigate to the following Windows Registry location:  
Computer\HKEY_LOCAL_MACHINE\SOFTWARE\Nitro\PDF Pro\CV\settings  

 

• To optimize for PCL print drivers:  Change the value of “PrintBandSize” to 1013760 (decimal) 

and the value of “PrintBandCountForIgnore” to 65535 (decimal). 

 

• For default print settings:  Change the value of “PrintBandSize” to 8388608 (decimal) and the 

value of “PrintBandCountForIgnore” to 8 (decimal). 

 

2. Restart Nitro PDF Pro 

 

Please Note:  Any modifications to the Windows Registry should only be performed by an IT Admin.  

It is always recommended to create a backup of the Windows Registry before making any changes. 
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3.3.1.4 iManage Work 10 

 

iManage Work 10 is a document and email 

management system designed to help 

professionals manage their work more efficiently. 

It provides a robust platform for storing, organizing, 

and accessing documents and emails within a 

secure and user-friendly interface.  

Nitro PDF Pro supports an integration with 

iManage Work 10.  By integrating Nitro PDF Pro 

with iManage ensures that all PDF files are 

automatically saved and indexed in a secure, 

centralized location, making it easy for users to 

find and retrieve documents.   

Follow the instructions below to enable the 

iManage 10 integration.  Please see Section 6.5 

for more details. 

 

 

“iManage Work 10” Tab of Deployment Utility 
Setting Description MSI Property 

Enable 

integration with 

iManage Work 

10  

Check the box to enable the integration with iManage 

Work 10. 
IMANAGEENABLED 

(Enabled = 1 / Disabled = 0) 

iManage Install 

Path  

 

Under the iManage Install Path, enter the path to the 

iManage Work folder under the iManage installation 

directory. The typical path is C:\Program 

Files\iManage\Work10\. This folder must contain the 

iManage DLLs.   

 

If the iManage Install Path is incorrect, the integration 

between Nitro PDF Pro and iManage will fail, causing 

issues where web-client documents may remain 

checked out until manually checked in. 

 

 

 

IMANAGEINSTALLPATH 
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3.3.1.5 Help Resources 

 

 

 

Knowledge Assistant is a chat-based tool 

designed to provide comprehensive answers to 

questions about Nitro products and services. 

Knowledge Assistant is designed to provide 

immediate product-specific assistance to users. 

Instead of searching through documentation or 

forums, users can ask questions directly in the 

chat interface. Knowledge Assistant can 

support users in multiple languages. 

 

The Knowledge Assistant tool is built using only 

data from Nitro’s knowledge base of support 

documentation and does not use customer 

data to train large language models.  

 

Follow the instructions below to enable or 

disable Knowledge Assistant.  
 

“Help Resources” Tab of Deployment Utility 
Setting Description MSI Property 

Enable 

Knowledge 

Assistant  

Knowledge Assistant is enabled by default. By leaving 

the checkbox selected, the tool will be visible under the 

Help ribbon in Nitro PDF Pro.  To disable Knowledge 

Assistant, uncheck the box.   

N/A 

 

 

Alternate Method:  Knowledge Assistant can also be disabled by updating a Windows Registry Key. 

 

1. Navigate to the following Windows Registry location: 
Computer\HKEY_LOCAL_MACHINE\SOFTWARE\Nitro\PDF 

Pro\CV\settings\doc_intelligence 

 

2. Change the registry key ‘enabled’ to /b 0 

 

 

Please Note:  Any modifications to the Windows Registry should only be performed by an IT Admin.  

It is always recommended to create a backup of the Windows Registry before making any changes. 
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3.3.2 Customizing Nitro PDF Pro: Creating an MST using Orca 

 

 

If you would like to modify the default 

installation settings, creating an MST file 

enables you to customize Nitro PDF Pro’s 

settings to better fit your organization's 

specific needs.  

 

Orca is an MSI database editor provided as 

part of the Microsoft Windows SDK. For more 

information visit: 

https://learn.microsoft.com/en-

us/windows/win32/msi/orca-exe. 

Orca lets you edit the installation files (MSI) 

for Nitro PDF Pro to create a Transform File 

(MST) that fine-tunes the installation 

process.  

 

 

3.3.3 Customizing Nitro PDF Pro: Using Command Line 

As an alternative to using the Nitro Deployment Utility to modify the Nitro PDF Pro installation defaults, 

some settings can be customized using command-line parameters. 

The basic command-line syntax to install Nitro PDF Pro is: 

msiexec /i “location of MSI file” /<options> Property=Value 

Below are various examples of using command-line to modify specific installation settings. 

Example #1:  Disable Microsoft Office add-ins 

msiexec /i “C:\Users\jsmith\Downloads\ nitro_pro_x64.msi” /qn 

OFFICEADDINS=0 

This syntax installs Nitro PDF Pro from the Downloads folder of the user “jsmith”. The option “/qn” 

specifies a quiet installation with no user interaction. “OFFICEADDINS=0” installs Nitro PDF Pro without the 

Microsoft Office add-ins for Word, Excel, PowerPoint, and Outlook. 

Example #2:  Disabling the Nitro Sign Integration  

msiexec /i “C:\Users\jsmith\Downloads\ nitro_pro_x64.msi” /qn 

SIGNENABLE=0 

This syntax installs Nitro PDF Pro from the Downloads folder of the user “jsmith”. The option “/qn” 

specifies a quiet installation with no user interaction. “SIGNENABLE=0” installs Nitro PDF Pro without the 

Nitro Sign integration. By disabling the integration, Nitro Sign will not be accessible from directly within 

Nitro PDF Pro, and all Nitro Sign related features will not be visible in the Nitro PDF Pro ribbon. 

https://learn.microsoft.com/en-us/windows/win32/msi/orca-exe
https://learn.microsoft.com/en-us/windows/win32/msi/orca-exe


Nitro PDF Pro (for Windows) Installation Guide – Enterprise Version 

 

P a g e |  14  
 

3.4 Deploying an MST (Transform File) Using Command-Line 

 
After creating an MST (Transform File), the MST can be deployed via the command-line. 

msiexec /i “C:\Users\jsmith\FolderName\ nitro_pro_x64.msi” TRANSFORMS=“ 

C:\Users\jsmith\FolderName\ nitro_pro_x64.mst” /qn 

• “msiexec” is the Windows Installer command-line utility. 

• “/i” specifies that you want to install the package. 

• "C:\Users\jsmith\FolderName\nitro_pro_x64.msi" is the path to the MSI 

installer file. 

• TRANSFORMS="C:\Users\jsmith\FolderName\nitro_pro_x64.mst" applies 

the MST file (modified configuration settings) during the installation 

• “/qn” specifies a quiet installation with no user interface. 

After running the command, Nitro PDF Pro should install silently. Check the installation by navigating to 

the installed location or verifying through the Control Panel under “Programs and Features”. If the 

installation fails, ensure the paths to the MSI and MSI files are correct, and check the log file for errors.  

 

A log file can be generated by modifying the command, as follows: 

msiexec /i "C:\Users\jsmith\FolderName\nitro_pro_x64.msi" 

TRANSFORMS="C:\Users\jsmith\FolderName\nitro_pro_x64.mst" /qn 

/L*V "C:\Users\jsmith\FolderName\install.log"  

 
This command will create a detailed log file (install.log) in the specified directory, which can help 

diagnose any issues that arise during the installation process. 
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3.5 Deploying in Virtual and Hosted Environments 
 

3.5.1 Virtual Desktop Infrastructures (VDI) 

 

Nitro PDF Pro is fully supported for deployment on VDI infrastructures, such as Citrix XenDesktop or 

VMWare Horizon.  Installation can be performed similarly to any other MSI-based application in your 

environment.   

 

Where a “master image” is being used to deploy to multiple identical hosts, the license file must be 

unencrypted. The Nitro PDF Pro license file is unencrypted by default. See Section 3.3.1.2 for more 

information about license file encryption. 

 

3.5.2 Hosted Desktop / Hosted Application 

 

Nitro PDF Pro is fully supported for deployment on hosted desktop or hosted application environments, 

such as Citrix XenApp or Microsoft Remote Desktop Services. Installation can be performed similarly to any 

other MSI-based application in your environment, with the following considerations:  

1. If an Enterprise license is used, access to Nitro PDF Pro must be controlled by using an Active 

Directory GPO, AppLocker, or the published application settings in the Citrix admin console. Failure 

to do so may result in accidental overuse of the license. 

 

2. Installation should be completed using InstallApplication on Terminal Server, found under the 

Control Panel. See the Microsoft best practices article for more details. 

 

If you choose to install the Nitro PDF Pro add-ins for Microsoft Office, please note that the add-ins will be 

installed for all users. However, the load behavior of the add-ins can be controlled on a per-user or per-

group basis using Active Directory GPOs.  See Section 6.3 for more details.  

 

3.5.3 Deploying Nitro PDF Pro Using Microsoft App-V 

 

Nitro PDF Pro can be deployed using Microsoft App-V; but the following considerations must be followed: 

1. License Key Encryption:  When creating the App-V package, ensure the license key encryption is 

disabled. The Nitro PDF Pro license file is unencrypted by default. Additional information on license 

encryption can be found in Section 3.3.1.2.   

 

2. Office Add-ins:  Nitro PDF Pro add-ins for Microsoft Office are not supported in an App-V streaming 

deployment.  The Nitro PDF Pro Office add-ins must be disabled. 

 

3. Nitro PDF Creator (Printer): The Nitro PDF Creator cannot be included in the App-V package, but is 

essential for creating PDF files and converting other file formats to PDF, so it must be installed 

separately on each target device.  

Note:  The Nitro PDF Creator is version-specific and must match the version of the Nitro PDF Pro 

application. Contact Nitro Support to get the standalone installation file for the Nitro PDF Creator. 

 

http://technet.microsoft.com/enus/library/cc742815(WS.10).aspx
https://www.gonitro.com/support/ticket
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3.5.3.1 Sequencing Nitro PDF Pro in App-V 

 

By following these steps, you can successfully deploy Nitro PDF Pro and the Nitro PDF Creator using 

Microsoft App-V, ensuring all necessary components are installed correctly 

1. Start Sequencing: 

• Launch the App-V Sequencing Wizard and select File > New Package. 

• For detailed instructions, visit the Microsoft TechNet article.  

 

2. Install Nitro PDF Pro:  

• Open the Command Prompt as an Administrator. 

• Install Nitro PDF Pro using the transform (MST) file with the following command: 

msiexec /i “C:\path_to\nitro_pro_x64.msi” 

TRANSFORMS=”C:\path_to\ nitro_pro_x64.mst” 

• (Optional Step) On the Launch Application page, start Nitro PDF Pro and click Launch.  

 

3. Complete Sequencing: 

• On the Sequence Package page, click Finish.  

 

3.5.3.2 Installing the Nitro PDF Creator on Target Devices 

 

1. Choose Installation Folder: 

• Install Nitro PDF Creator in any folder other than "Program Files" or "Program Files(x86)" 

 

2. Specify Installation Path: 

• Use the “INSTALLLOCATION” property to specify the folder path. 

 

3. Open Command Prompt:  

• Run Command Prompt as an Administrator. 

 

4. Run Installation Command:  

• Execute the following command: msiexec /i Nitro_Creator_x64.msi 

INSTALLLOCATION="c:\Nitro\Creator". 

• Restart the computer the complete the installation. 

 

 
3.5.4 Citrix Provisioning Services / Machine Creation Services 
 
Nitro PDF Pro is fully supported on devices with streamed operating systems using Citrix PVS or Machine 

Creation Services (MCS).  
 
For a successful deployment, the license file must be unencrypted. The Nitro PDF Pro license file is 

unencrypted by default. See Section 3.3.1.2 for more information about license file encryption. 

If in addition to PVS/MCS, other technologies such as XenApp or App-V are used to provide access to Nitro 

PDF Pro for users, please refer to the relevant sections of this guide for additional requirements. 

https://technet.microsoft.com/en-us/library/cc817128.aspx
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4 Setting Nitro PDF Pro as the Default PDF Application 

Due to changes made by Microsoft, Nitro PDF Pro cannot be set as the default PDF viewer automatically 

during installation. A few additional steps are required to make Nitro PDF Pro the default PDF application.  

 

4.1 Setting Nitro PDF Pro as the Default:  

On Individual Workstations  

 

Option 1: Change the Default PDF Application from 

Preferences 
 

   

1. Open Nitro PDF Pro and go to Preferences 

 

2. Select General from the left-hand column 

 

3. Click Set Default Programs and follow the 

prompts to set Nitro PDF Pro as the default 

PDF viewer 

 

 

Option 2: Change the Default PDF Application Using "Open with" in File Explorer   
 

1. After Nitro PDF Pro is installed on the workstation, from File Explorer right-click on any PDF file, 

and from the context menu, select Open With 

 

2. Select Choose another app to open the prompt window with a list of PDF applications 

 

3. Select Nitro PDF Pro from the list and click Always use this app to open .pdf files 

 

4. The above steps can be repeated to set Nitro PDF Pro as the default application for  

FDF, XFDF, and PPDF files 

 

 

 

Option 3: Change the Default PDF Application 

through Settings  

 
1. Click on the Start menu.  Go to Settings > 

Apps > Default apps 

 

2. Select Set defaults by app 

 

3. Select Nitro PDF Pro and click Manage 

 

4. Select Nitro PDF Pro as the default app for 

PDF, FDF, XFDF, and PPDF files 
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4.2 Setting Nitro PDF Pro as the Default: On Multiple Workstations  

Setting the default application for multiple workstations can significantly streamline your IT management 

process, ensuring consistency and efficiency across your organization. By creating an XML file and 

deploying it using Group Policy Objects (GPO), you can easily configure the default application settings for 

all users. This approach not only simplifies the deployment process but also ensures that all workstations 

are configured uniformly, reducing the potential for user error, and improving overall productivity.  

Follow the steps outlined in this section to create the necessary XML file and deploy it using GPO, ensuring 

a seamless and consistent setup across your entire network.  

 

Step 1: Creating the Default Application Associations XML File  

 

1.  On a computer that has Nitro PDF Pro installed, go to the Start menu, and select Settings > 

Apps > Default apps.  

 

2. Select Nitro PDF Pro as the default for file types, PDF, FDF, XFDF, and PPDF 

 

3. Execute the following command:  
Dism.exe /online /export-defaultappassociations:<path and 

filename>  

  

Example:  Dism.exe /online /export-

defaultappassociations:C:\AppAssocations.xml  

 

4. The default application associations 

will be exported in XML form. The 

resulting XML file will contain all 

default application associations of 

the client machine.  

 

 

5. Open the XML file in a text editor 

(e.g., Notepad) and remove all the 

<Association Identifier=” entries not 

referring to NitroPDF. Do not 

remove any other lines.  

 

The resulting file should look as below.   
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Note: If the policy setting is not able to access the file in the specified location, the change of 

default application association will fail without any error messages.  

 

 

 

 

 

 

 

Note: As an alternative to Steps 2 -5, the following XML file can be downloaded and used to set 

Nitro PDF Pro as the default application for PDF, FDF, XFDF, and PPDF files: 

https://www.gonitro.com/installers/CV/enterprise/download. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The XML file needs to be accessible from all client machines that require the settings to be changed. The 

easiest and most reliable option would be to copy the file to the same location for all clients, e.g., 

C:\AppAssociations.xml. 

 

The file could also reside on a mapped network drive that all clients have access to, e.g., 

P:\AppAssociations.xml. In this case, ensure that:  

• All clients use the same drive letter for this location.   

• The drive is mapped before the policy setting is applied.  

 

 

 

 

 

 

  

Step 2: Applying the GPO Setting  

 

Applying the GPO setting will configure a policy to force client computers to use a specific file for their 

application defaults. The policy setting only contains the path to the file, which needs to be made available 

to all applicable client machines.  

 

The file type association will be applied every time the policy applies. If a user manually changes this 

setting, or another application changes it, it will be reset with the next policy refresh (e.g., reboot).  

 

 

  

1. Open the Group 

Policy Management 

console, create a 

new policy, or select 

an existing one. 

Right-click and 

select Edit.  

  

  

  

https://www.gonitro.com/installers/CV/enterprise/download


Nitro PDF Pro (for Windows) Installation Guide – Enterprise Version 

 

P a g e |  20  
 

Note: The XML file needs to be accessible from all client machines that require the settings to be 

changed. If you configure the file location to be used as “C:\”, ensure the XML file exists on all 

client computers in that location. If you use a mapped network drive instead, ensure all clients 

have access to it. The mapping must occur before the policy is applied, or the GPO will fail 

without any error messages. 

 

 

 

 

 

 

 

 

2. Locate the setting Set a default 

associations configuration file in 

Computer Configuration > 

Administrative Templates > 

Windows Components > File 

Explorer.  

 

Double-click on it to open the 

configuration window. 

 

3. Set the policy to Enabled and 

specify a valid path to the created 

XML file.    

 

Example: 
C:\AppAssociations.xml 
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5 Updating Nitro PDF Pro 

 
Nitro releases a minor update (e.g., Nitro PDF Pro 26.0 to Nitro PDF Pro 26.1) approximately every three to 

six weeks. The Enterprise version of Nitro PDF Pro for Windows does not automatically check for updates, 

each new update of Nitro PDF Pro requires a new installation.   

 

The latest Enterprise version of Nitro PDF Pro (for Windows) can be downloaded at:  

https://www.gonitro.com/installers/CV/enterprise/download.  

 

To obtain installers for earlier versions of Nitro Pro, please contact Nitro Support. 

 

5.1 Minor Updates 

 

Nitro PDF Pro can be updated to the latest version by performing an on-the-top installation. Using the 

standard Nitro PDF Pro installer (MSI) will install Nitro PDF Pro with the default settings, as described in 

Section 3.1.1. If your current Nitro PDF Pro installation has custom settings, you will need to recreate 

these settings when installing the upgrade. See Section 3.3 for details about creating a custom transform 

(MST) file to modify the default installation settings.   

The same Enterprise license file can be used to activate all minor versions of Nitro PDF Pro throughout the 

subscription period. However, each major version (v14, v13, v12) of Nitro PDF Pro requires a separate 

license file.  To obtain a license file for earlier versions of Nitro PDF Pro (v13 or earlier), please contact 

Nitro Support. 

 

5.2 Major Updates 

When upgrading to Nitro PDF Pro 26, any version of Nitro PDF Pro 14, 13, or 12 will be automatically 

uninstalled during the upgrade process.  

When installing or upgrading to Nitro PDF Pro 26 for the first time, the installation may require a restart of 

Windows when the installation is complete.  The restart is required due to an update to the Microsoft 

runtime files.  This only needs to be done once, and future updates to subsequent versions of Nitro PDF 

Pro 26 will not require this Windows restart. 

To prevent an automatic restart after the installation a NORESTART switch can be used via the MSIEXEC 

command-line.  

Using the Default MSI: 
msiexec /i “path-to-msi-file” /qn /norestart 

 

Using the MST (Transform File): 
msiexec /i “path-to-msi-file” TRANSFORMS=”path-to-mst file” /qn /norestart 

 

 

  

https://www.gonitro.com/installers/CV/enterprise/download
https://www.gonitro.com/support/ticket
https://www.gonitro.com/support/ticket
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5.3 Retaining Configuration Settings during Version Updates 

When updating Nitro PDF Pro, the following user data and settings are retained for both major and minor 

version updates.  No action is needed to retain the following user settings. 

 

• QuickSign Profiles 

• Custom Stamps 

• Digital IDs 

• Digital Signatures 

• Certificates 

• Security Profiles 

• Scanner Profiles 

 

 

5.4 Reactivating Nitro PDF Pro with a New License File 

Enterprise license files expire at the end of the subscription period and cannot be extended. Upon 

subscription renewal, a new license file will be provided that is valid for the new subscription period.  

 

To ensure uninterrupted service for all users, Nitro PDF Pro must be reactivated using the new license. 

Nitro PDF Pro can be reactivated with a new license without having to repackage or reinstall. Deploy the 

following reactivation script to reactivate Nitro PDF Pro without reinstalling. 

“C:\Program Files\Nitro\PDF Pro\CV\ActivateSN.exe” -s <FULL SERIAL NUMBER> 

If Nitro PDF Pro has been deployed on a virtualized environment or master image, add “-e false” to the 

syntax to ensure the license file is unencrypted: 

“C:\Program Files\Nitro\PDF Pro\CV\ActivateSN.exe” -e false -s <FULL 

SERIAL NUMBER> 

To obtain the full serial number (typically between 400-500 characters), open the new Enterprise license 

(.lic) file in Notepad and copy the full string. 

 

Example: 
"C:\Program Files\Nitro\PDF Pro\CV\ActivateSN.exe" -e false -s 

eyJQYXlsb2FkIjp7IkN1c3RvbWVyTmFtZSI6IkdIRCBTZXJ2aWNlcyIsIlByb2R1Y3ROY

W1lIjoiIiwiTGljZW5zZVV1aWQiOiI5NGVjMWE3My1kMzJjLTRmZmUtYWQ5Zi1kMzMyM2

ZkMmEwYjEifSwiU2lnbmF0dXJlIjoiQVRrcm16R1lNaU1NdU0zdU9QcW5sQ3p5c2J1bkE

4QmRqYXgwSE9EY0RCZ3JBSUJSamlnK2dPT09RRENQRzRUKzd4ZWZmUWlNWklKa3VwTXBK

cjBueW5rSEFDSGs1YWUwNWdoWm4yZmZrSCtsVHB3M0tpanc4dmU1NlQySU5DNGp4WDA2T

TU2d2FYUjlIcUhWZHErL0ZkSDQyWEhw UjN0e16R1lNaU1NdU0zdU9Qc  
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6 Special Configurations 

 

6.1 Multilingual Installer: Selecting Application Language 

 
Nitro PDF Pro is available in six languages: 

• English  

• German  

• French 

• Spanish 

• Italian 

• Dutch 

 

The application language can be changed at the time of deployment or changed by the user at any time 

after installation. 

 

6.1.1 Setting the Application Language on Individual Workstations 

 

Nitro PDF Pro delegates the choice of the application language to an end-user. Unless the application 
language is specified at the time of deployment, the user is prompted to select a preferred language at 
the first launch of Nitro PDF Pro. Users can also change the application language at any time after first 

use by going to Nitro PDF Pro Preferences. 

 

 
 

1. Go to File > Preferences 

 

2. Select Language from the left-hand 

column 

 

3. Select the desired Application 

Language from the drop-down 

menu 

 

4. Click Apply and OK 

 

5. Restart Nitro PDF Pro to apply the 

changes to the application 

language 
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Example:  
msiexec /i “C:\path_to\nitro_pro.x64.msi” NPSERIAL=<FULL SERIAL> 

APPLICATION_LANGUAGE=de-DE 

 

 

 

 

 

 

 

 

6.1.2 Setting the Application Language during Installation 

 

Nitro PDF Pro is available as a multilingual installer, making it simpler for administrators to customize the 

language of the application interface. 

 

Administrators can now deploy Nitro PDF Pro with a single installer – localized installers are not required. 

The language of the deployed application can be defined during the installation process, or the choice can 

be delegated to the end-user. 

 

The default option is “Select on application startup”. This option allows each end user individually to select 

a language of Nitro PDF Pro after installation on the first run of Nitro PDF Pro. 

 

Installing Nitro PDF Pro using the standard installer (MSI) or via command-line will install Nitro PDF Pro with 

the option “Select on application startup” by default. This means the user will be prompted to select 

language at the first run of Nitro PDF Pro. 

 

If an administrator prefers to specify the language of Nitro PDF Pro, they can install via command-line using 

an additional parameter 'APPLICATION_LANGUAGE' with one of the following values: 

 

• English:  APPLICATION_LANGUAGE=en-US  

• German:  APPLICATION_LANGUAGE=de-DE 

• French:  APPLICATION_LANGUAGE=fr-FR 

• Spanish:  APPLICATION_LANGUAGE=es-ES 

• Italian: APPLICATION_LANGUAGE=it-IT 

• Dutch:  APPLICATION_LANGUAGE=nl-NL 

  

 

 

 
 

 

 

 

If the language is defined incorrectly using 

command-line, Nitro PDF Pro will be installed 

with the English interface. 

 

The application language can also be selected 

when creating a Transform (MST) file to 

customize installation settings.   

 

See Section 3.3.1.1 for more details about 

customizing the application language when 

creating an MST. 
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6.2 Additional OCR Language Packages 

 
There are multiple OCR language 

packages built-in to Nitro PDF Pro:  

• Danish 

• Dutch  

• English 

• Finnish 

• French 

• German 

• Italian 

• Norwegian 

• Portuguese 

• Spanish 

• Swedish 

 

 

No action is needed to install these OCR 

languages.  They are available in each 

build  

of Nitro PDF Pro 26.  

 

 

 

The following OCR language packages can be installed in addition to the standard, built-in OCR languages: 

• Simplified Chinese 

• Traditional Chinese 

• Japanese 

 

Each additional OCR language package should be installed on top of the existing Nitro PDF Pro installation. 

OCR language packages are version specific. Please ensure the OCR language package version 

corresponds with the installed version of Nitro PDF Pro.  

 

To install:  

1. Download the OCR installer that corresponds with the Nitro PDF Pro version:  

https://www.gonitro.com/installers/CV/enterprise/download. 

 

2. From File Explorer, right-click on the downloaded OCR installer file (.EXE) and choose Run as 

Administrator.  

 

3. After installing, the user can select the OCR language recognition by going to File > Preferences 

> OCR, then select the desired OCR language from the dropdown under Language. 

 
The OCR installer (.EXE) can be deployed to multiple users using a software deployment solution like SCCM 

or Intune. 

  

https://www.gonitro.com/installers/CV/enterprise/download
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6.3 Ensuring Nitro PDF Pro Outlook Add-ins Remain Enabled 

 
In Office 2013 and later versions, programs automatically disable add-ins that perform slowly. To keep the 

Nitro PDF Pro add-ins enabled, you can adjust the settings using the registry or Group Policy. By following 

these steps, Nitro PDF Pro add-ins will remain enabled and functional in Outlook. 

 

Step 1: Ensure Nitro PDF Pro Add-ins Load at Startup  

 

To make sure the Nitro PDF Pro Outlook add-in always loads when you start Outlook, follow these steps: 

1. Open the Windows Registry Editor. 

 

2. Add the following registry key: 
HKEY_CURRENT_USER\SOFTWARE\Microsoft\Office\Outlook\Addins\N

itroPDFProfessional.MSOfficeAddin. 

 

3. Change the value of LoadBehavior to ‘3’. 

 

Example Command for Office 365:  
REG ADD 

HKCU\SOFTWARE\Microsoft\Office\Outlook\Addins\NitroPDFProfessi

onal.MSOfficeAddin /v "LoadBehavior" /t REG_DWORD /d 3 /f  

 

  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 2: Disable Resiliency Check for Nitro PDF Pro Add-ins.  
 

To prevent Outlook from disabling the Nitro PDF Pro add-in, follow these steps to disable the Office 

Resiliency check for the Nitro PDF Pro Outlook add-in. 

1. Open the Windows Registry Editor. 

 

2. Add the following registry key: 
HKEY_CURRENT_USER\Software\Microsoft\Office\X.0\Outlook\Resiliency\Do

NotDisableAddinList. 

 

Note:  Replace X.0 with your version of Office (e.g., 16.0 for Office 2016/2019/365, 15.0 for 
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Office 2013). 
 

3. Add a new DWORD value named NitroPDFProfessional.MSOfficeAddin and set its value 

to ‘1’. 

 

Example Command for Office 365:  
REG ADD 

HKCU\SOFTWARE\Microsoft\Office\16.0\Outlook\Resiliency\DoNotDisableAd

dinList /v "NitroPDFProfessional.MSOfficeAddin" /t REG_DWORD /d 

00000001 /f  

 

 

4. If an add-ins group policy is enforced in an environment, the following registry setting is enabled: 

 
Registry Path: 

HKEY_CURRENT_USER\Software\Policies\Microsoft\Office\16.0\Outlook\Res

iliency\AddinList 

Value Name: policyon 

Value Type: REG_DWORD 

Value: 1 

 

5. The following registry key will also be required to allow you to specify the list of managed add-ins 

that are always enabled, always disabled (blocked), or configurable by the user.  

 
Registry Path: 

HKEY_CURRENT_USER\Software\Policies\Microsoft\Office\16.0\Outlook\Res

iliency\AddinList 

Value Name: NitroPDFProfessional.MSOfficeAddin 

Value Type: REG_SZ 

Value: 1 

 

 

For more details, please refer the following Microsoft article on keeping add-ins enabled. 

  

https://msdn.microsoft.com/en-us/vba/outlook-vba/articles/support-for-keeping-add-ins-enabled
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6.4 SharePoint Online Extension  
 

The Nitro PDF Pro SharePoint Online extension is an easy-to-use tool that lets users open a SharePoint 

Online document in the Nitro PDF Pro desktop application from within the web browser. With the Nitro PDF 

Pro SharePoint online extension, users can work with SharePoint Online documents without having to 

manually download, edit, and upload them. Users can now edit SharePoint documents in just a few clicks. 

 

Preconditions:  

• The Nitro PDF Pro SharePoint online extension only works with SharePoint Online sites 

with Modern View. Classic view is not supported.  

• To deploy the SharePoint Online extension, Admin permissions are required. 

 
 

6.4.1  SharePoint Online Extension Deployment  

 
The Nitro PDF Pro SharePoint online extension is not available on Microsoft Marketplace as each 
package requires to work with a compatible Nitro PDF Pro version.  

 

1. Download the SharePoint Online extension package (SPPKG) from 

https://www.gonitro.com/installers/CV/enterprise/download.*   

 

2. Please refer to the instructions from 

Microsoft on adding Custom Apps. 

Use the App Catalog to make custom 

business apps available for your 

SharePoint environment.  

 

3. During the deployment, the Nitro PDF 

Pro SharePoint Online extension 

provides an option to deploy the 

package tenant-wide or per site. If the 

package is deployed tenant-wide, it 

will be automatically available for use 

on all sites and sub-sites of the 

current SharePoint tenant.  

 

 

 

Alternatively, the package can be enabled manually on specific sites. 

 

To enable manually:  

 

1. Open SharePoint site settings and select Add an app.  

 

2. From the left-hand menu, select From my organization.  

 

3. Search for the Nitro Pro For SharePoint Online application  

and click Add.  
 

  

https://www.gonitro.com/installers/CV/enterprise/download
https://learn.microsoft.com/en-us/sharepoint/use-app-catalog#add-custom-apps
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If the SharePoint extension is deployed correctly, the Open in Nitro option will appear on the command bar 

and in the document context menu. 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

  

 

 

 

*IMPORTANT:  The current version of the SharePoint Online extension (v1.16.0.x) only supports 

Nitro PDF Pro v14.3 and later. To get a SharePoint Online extension package that is compatible 

with earlier versions of Nitro PDF Pro (before v14.3), please contact Nitro Support. 

 

 

 

 

 

6.4.2 User Consent & Permission Requirements 
 

The first time a user opens a document using the SharePoint Online extension, they may be prompted to 

accept consent. It is recommended that an admin log in to SharePoint Online from Nitro PDF Pro and 

accept the consent on behalf of the organization.  

 

To open and save a document in SharePoint Online, Nitro PDF Pro requires additional access to the 

SharePoint Online server. However, the extension itself does not need any extra permissions to access the 

document. As a client-side extension, it operates with the logged-in user’s permissions and can only 

access files the user has permission to view. 
 

  

https://www.gonitro.com/support/ticket
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The following table lists the different permissions required by Nitro PDF Pro. These permissions ensure 

that Nitro PDF Pro can fully interact with SharePoint Online and other necessary services while maintaining 

user security and data integrity. 

 
 

Nitro PDF Pro Permissions Overview Table 
 

Permissions Description Needed for feature 

Type:  Delegated 

user_impersonation    

Allows creating and accessing protected 

content on behalf of the user.  

  

Requested by MIP SDK when reading policy and 

labels. 

• Azure Information 

Protection   

UnifiedPolicy.User.Read    

Allows reading all unified policies a user has 

access to. 

  

Requested by MIP SDK to protect a document  

• Azure Information 

Protection   

User.Read    

Allows signing in and reading the user’s profile. 

  

Generally required for sign-in, as specified in 

Microsoft documentation.  

• SharePoint Online   

• OneDrive   

• Azure Information 

Protection   

Files.ReadWrite    
Provides full access to the user’s files.  • OneDrive  

• SharePoint Online   

Sites.Manage.All    

Allows creating, editing, and delegating items 

and lists in site collections. 

  

Needed to upload files to SharePoint.   

• SharePoint Online  

Offline_access    

Maintain access to data the user has given 

access to.  

  

Provides access to refresh tokens, required 

according to Microsoft documentation. 

• OneDrive  

• SharePoint Online   

Type:  Application 

Content.DelegatedWriter  

Allows creating protected content on behalf of a 

user. 

  

Requested by MIP SDK to protect a document.  

• Azure Information 

Protection   
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6.4.3 Managing OAUTH Access Tokens  

 
 

To use the SharePoint Online extension, Nitro PDF Pro manages your access tokens securely. Here’s how it 

works: 

 

• Where the Token in Stored:  The access token is stored in: 
C:\Users\<user>\AppData\Roaming\Nitro\PDF 

Pro\CV\ms_graph_token_cache.msal. 

 

• Security: The token is encrypted using the Microsoft.Identity.Client library, which ensures your 

data is safe. 

 

• Encryption Method: Nitro PDF Pro using Windows Data Protection API (DPAPI) to encrypt the 

token, which means it uses your Windows login credentials for encryption. 

 

• Login Information:  The only user information Nitro PDF Pro stores is your login email.  This is 

saved in the registry at: HKEY_CURRENT_USER\Software\Nitro\PDF 

Pro\CV\Settings\MicrosoftAccount\email. 

 

• Additional Handling:  All other access details are managed by the AIP SDK, which integrates the 

MSI and MSIPC folder, and the Microsoft.Identity.Client library. 

 

By following these methods, Nitro PDF Pro ensures that your access tokens and login information are 

securely handled and protected. 

More information about Microsoft Identity platform and authentication can be found here:  

https://docs.microsoft.com/en-us/azure/active-directory/develop/v2-oauth2-auth-code-flow. 

https://docs.microsoft.com/en-us/azure/active-directory/develop/v2-oauth2-auth-code-flow
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6.5 iManage 10 - Integration  

 
Nitro PDF Pro supports an integration with iManage 10. Integrating Nitro PDF Pro with iManage ensures 

that all PDF files are automatically saved and indexed in a secure, centralized location, making it easy for 

users to find and retrieve documents.   

 

The Nitro PDF Pro iManage 10 integration provides a seamless workflow for the end-users to Open and 

Save documents from iManage repositories.  

 

Once the iManage integration is enabled, Nitro PDF Pro will display an additional iManage tab with the 

available features as below:  

  

  

 

 
 

6.5.1 Server-Side Configuration  

 

Step 1: Add Nitro PDF Pro to the allowed apps on the iManage Server  

  

In iManage Control Center (IMCC), add Nitro Pro to the list of allowed applications using the methods 

below:  

 

• If you use an account on cloudimanage.com, select and add Nitro Pro from the 

Application List.  

• If you use another iManage 10.2+ server (cloud or on-premises), add Nitro Pro 

manually with a predefined Client ID as follows:  

  

Client ID / API Key  0127f653-a333-483f-b6b4-fb452b5959a7  

Client Secret / API 

Secret  

<autogenerated>  

Redirect URL  http://localhost/  

Application Type  Native  

  

 

 

Note: If you have more than one iManage server, this step must be done on each iManage server.  

 

 

 

More information on IMCC and applications can be found here. 

 

https://docs.imanage.com/cc-help/10.4.0/en/Applications.html
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Step 2: Register NitroPDF as an integrated application 

  

1. Download imWorkOptions.xml file from IMCC. If there is no such file, the template can be 

downloaded from iManage Help Center or created manually.  

 

2. In imWorkOptions.xml, add the section that marks NitroPDF as an integrated application:  

 
<ws_options>      

     <ws_option name="integration">          

          <key name="IntegratedProcesses" value="NitroPDF"/>      

     </ws_option>  

</ws_options>  

 

 

IMPORTANT: 

• Ensure that “<ws_options>” does not contain attribute “applyToAll”. If this attribute 

exists, please remove it. 

• The value of “IntegratedProcesses” must be exactly “NitroPDF” as it corresponds to 

the name of Nitro PDF Pro process on a client. 

 

 

  

3. Upload the result document back to the IMCC.  

 

4. To update the configuration on a client side, it is required to reconnect to the iManage server.  

 

 

For more information see the iManage Work Desktop for Windows Customization Guide. 

 

  

Step 3: Enable refresh token for Nitro PDF Pro on iManage server  

 

1. Download the iManage_enable_refresh_token script from: 

https://www.gonitro.com/installers/CV/enterprise/download.   

 

2. Unpack the .zip file and follow the instructions from “readme.txt”.  

 

 

Note: If you have more than one iManage server, this step must be done on each iManage server. 

 

 

 

 

 

  

https://docs.imanage.com/wdw-custom-help/10.6.0/en/iManage_Work_Desktop_for_Windows_Customization_Guide.html
https://www.gonitro.com/installers/CV/enterprise/download
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6.5.2 Client-Side Configuration  

 

The Nitro PDF Pro iManage integration must be enabled when deploying Nitro PDF Pro on user 

workstations. Enabling the iManage integration will require an MST to be created using the Nitro 

Deployment Utility. See Section 3.3.1.4 for more details.  

 

 

 

  

1. Ensure that iManage Work Desktop 

for Windows 10.5 or newer (also 

known as iManage Agent) is running 

and connected to the iManage server. 

This is a required component.  

 

2. Generate an MST file with the 

iManage integration enabled.  See 

Section 3.3.1 for details about 

creating an MST file using the Nitro 

Deployment Utility. 

 

3. Install Nitro PDF Pro with the created 

MST file.   

 

4. Set Nitro PDF Pro as the default PDF 

viewer. 

 

 

 

 

 

 

 

 

IMPORTANT:  To ensure Nitro PDF Pro can find the necessary iManage DLLs, the path must be set 

to the iManage Work folder. If the iManage Install Path is incorrect when creating the MST, the 

integration between Nitro PDF Pro and iManage will fail, causing issues where web-client 

documents may remain checked out until manually checked in.  
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6.6 Microsoft Purview (Azure IP) Integration 

 

Microsoft Purview, also referred to as Azure Information Protection (AIP), MS AIP, or Azure IP, is a solution 

that helps companies increase document security for sensitive information by applying labels. Nitro PDF 

Pro can be integrated with Microsoft Purview to ensure that all PDF documents created and opened with 

Nitro PDF Pro respect the labels and permissions set by the author.  

 

6.6.1 Enable Microsoft Purview (Azure IP) Integration  
 

To enable the Microsoft Purview integration with Nitro PDF Pro, you need to update a registry key to enable 

classification and labeling. Once Nitro PDF Pro is installed and activated on workstations, follow these 

steps: 

 

1. Open the Windows Registry Editor.  (Nitro PDF Pro must be closed.) 

 

2. Navigate to: HKEY_LOCAL_MACHINE\SOFTWARE\Nitro\PDF Pro\CV\settings\. 
 

3. Add or change the value of the following key: 

“MSAzureLabelingEnabled”=dword:00000001 

 

 

The following steps are required to add Nitro Pro to the Azure tenancy to allow the Azure Administrator to 

grant Admin consent for this application. 

 

1. Launch Nitro PDF Pro on a reference 

workstation. 

 

2. Wait for the Single Sign-on (SSO) dialogue to 

appear, then log in as the Azure Administrator. 

 

NOTE: If the Windows user account does not 

have an associated email, Nitro PDF Pro will 

prompt to enter an email before showing the 

SSO dialogue.  

 

3. After logging in, Nitro PDF Pro will display a 

prompt to accept User Consent. (Ensure the 

account being used has Admin level privileges.) 

Accept the consent on behalf of your 

organization. 

 

4. Nitro PDF Pro is now successfully logged in to 

Azure. 
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6.6.2 Grant Admin Consent 

To grant Admin consent in Azure, follow these steps:  

1. Sign in to the Azure portal as a Global Administrator, 

Application Administrator, or Cloud Application 

Administrator.  

 

2. Go to Manage Azure Active Directory, then Enterprise 

applications on the left-hand panel.  

 

3. Click on Nitro PDF Pro from the list of applications.  

 

4. From the left-hand panel, click Properties.  

 

5. Ensure that the Application ID is a98220f5-06d3-

4bc5-9520-c7454eb24460. 

 

6. Ensure that Enabled for users to sign in? is set to Yes.  

 

7. On the left-hand panel, select Permissions. 

 

8. Click Grant Admin consent for <your_tenant_name>.   

 

9. Log in as the Azure Administrator. (You may be 

prompted to log in twice.)  

 

10. After successful login, the consent dialogue will appear. 

Click Accept to add Admin consent for Nitro PDF Pro.   

 

 

6.6.3 Supported Features  
 

• Access to AIP-protected documents: Users can work with AIP-protected PDF documents in Nitro 

Pro, depending on the document permissions.  

  

• Notification for documents classified with Sensitivity label: When a user opens a classified 

document or applies a Sensitivity label, Nitro PDF Pro shows a notification with the label name, 

indicating that the document is classified and will be tracked. 

  

• Access to labels: Nitro PDF Pro displays labels associated with the current user’s policy, as defined 

by the Azure admin.  

  

• Classify a PDF document: Users can apply a Sensitivity label to an unprotected PDF document. If 

the label includes protection, the document will be encrypted. 

  

• Protect a PDF document: Users can apply custom protection to a document by using a label with 

specific permissions and recipients. 

  

• Automatically apply Sensitivity labels: Nitro PDF Pro follows policy rules published to the user, such 

as providing justification for removing or downgrading classification, applying default labels to new 

or existing unprotected documents, and requesting a label application before saving an 

unprotected document. 
  

https://portal.azure.com/
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7 Contacting Nitro Support 

 
If you encounter any issues or have questions, our support team is available 24-hours a day, 365 days  

a year. Our team of technical support engineers provide round-the-clock deployment and activation 

assistance.  

  

To contact Nitro Support:  

 

1. Go to https://www.gonitro.com/support/ticket. 

 

2. Enter your name and work email address. 

 

 

3. Describe the issue you are experiencing.  For 

deployment issues, please detail your 

deployment method and any anti-virus software 

used that could be interfering with installation.  

 

4. Select your Nitro PDF Pro version (PDF Pro 26, 

PDF Pro 14, PDF Pro 13 or earlier)  

 

5. Select your operating system from the 

dropdown. 

 

6. Please include a screenshot of the issue or error 

message, if applicable.  

 

You will receive an automated email with your 

support case reference number and a Nitro Support 

Engineer will respond promptly by email.  

 

 

For general support related to product usage and functionality, Nitro has a full suite of self-help resources, 

including videos, user guides, knowledge base articles, and community forum.  

   
• User Guide: Get step-by-step instructions for using Nitro PDF Pro with our comprehensive Nitro PDF 

Pro User Guide.  

• Video Library: Choose from a collection of short videos to learn how to use core features in Nitro 

PDF Pro.  

• Knowledge Base: Get on-demand answers to your product-related questions across hundreds of 

knowledge base articles.    

https://www.gonitro.com/support/ticket
https://www.gonitro.com/user-guide
https://www.gonitro.com/support/video-library
http://kb.gonitro.com/knowledgebase
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• Knowledge Assistant: Use our chat tool for an improved search experience and quick and accurate 

results across our extensive knowledge base.    

052520271550 

https://nitro-assistant.gonitro.com/
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